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1. SPTO Configuration Tool

1.1. Overview

The SPTO Configuration Tool gives the relay engineer a powerful tool for 
monitoring and configuring of the SPTO 1D2, 1D5, 1D6 and 6D3 control modules 
in the SPAC feeder terminal series.

1.1.1. Description

This Tool is used for Relay units regarding:

• Configuration of the object indication presented on the SPTO LED matrix 
display.

1.1.2. Target systems

Control modules SPTO 1D2, SPTO 1D5, SPTO 1D6 in SPAC 300 series and S
6D3 in the SPAC 500 and 600 series in the SPACOM range of products.

1.1.3. Communication support

• Serial SPA

1.1.4. Features/options

• Parametrisation

• Upload and download of parameters

1.2. When is the SPTO Configuration tool needed?

The SPTO 6D3 module does not have any built-in status indicator configuratio
activate, thus the SPTO Configuration Tool is always needed for configuring t
status indication.

You should configure the SPTO 1D2, 1D5, 1D6 in the SPAC 300 series with t
SPTO Configuration Tool when you cannot benefit from the built-in factory defa
setting groups in the module, or whenever you want to make an own configura

Activation of the built-in led configuration is done by giving the number of the 
desired setting group to parameter S100 in the Relay Setting Tool and sendin
the module. When using the SPTO Configuration Tool it is assumed that the u
intends to make an own configuration, thus S100 is set to "0" which equals to free 
programming mode.

On the contrary, selecting another default group for S100 in the Relay Setting 
will replace the configuration made earlier by the SPTO Configuration Tool, un
it is the same of course!
B Automation 1
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2. Starting and using SPTO Configuration tool

Before the SPTO Configuration Tool can be taken into use, an initial preparation 
might be required. I.e. a SPAC terminal have to be inserted and configured for use 
in the Project Structure Navigator and the setup of communication between the relay 
and the tool has to be performed. Please refer to SM/SPACOM part of the Tools for 
Relays and Terminals manual�for more detailed information concerning the initial 
preparations.

)LJ������ 6WDUWLQJ�6372�&RQILJXUDWLRQ�7RRO�IURP�WKH�3URMHFW�6WUXFWXUH�1DYLJDWRU

The SPTO Configuration Tool is started by double-clicking on the ‘SPTO 
Configuration Tool’ in the Object Tools list box in the Project Structure Navigat
The SPTO Configuration Tool view opens (see Figure 2.1.-1).

The SPTO Configuration Tool is explicitly designed for use with SPTO module
I.e. when starting the SPTO Configuration Tool for a terminal not containing SP
modules of the desired kind, an information message is shown, see Figure 2.-

)LJ������ 1R�6372�PRGXOH�IRXQG�LQ�WKH�UHOD\

The tool uses a module specific internal parameter file for storing the paramet
values. The parameter file is created with the default values by the relay 
2 ABB Automation
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configuration dialog box when the relay is installed into the project structure. The 
file is maintained by the SPTO Configuration Tool. The parameter values are 
updated to the parameter file every time when uploading is performed. All the values 
displayed by the tool are read from the parameter file. For example, if you upload 
parameter values, they are first updated to the file and after that read from the file to 
the tool.

2.1. SPTO Configuration tool overview

The tool automatically selects the SPTO control module in the selected terminal.

Explanations to the SPTO Configuration Tool (see Figure 2.1.-1):

1. Menu with three items

2. Toolbar buttons, four pieces
3. Module type
4. Selected object
5. Drop down combo boxes for configuring of the selected indicator

The SPTO Configuration Tool, see Figure 2.1.-1,contains one view with 16 leds, 
number 1 to 16, in four columns. There are two different column types; thus 
enabling the use of both red or green colors for indicating closed in both horisontal 
or vertical direction.
B Automation 3
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)LJ�������� 6372�&RQILJXUDWLRQ�7RRO�PDLQ�YLHZ

2.2. Configuring by means of the SPTO Configuration tool

2.2.1. Introduction

There are several subsets of parameters in a SPTO module. Some of these subsets 
are related to another subset. Configuring the SPTO status indicators is only one 
subset. Two tools are needed for a successful configuration of a SPTO control 
module:

1. SPTO Configuration Tool

2. Relay Setting Tool

The recommended configuration order is to start with the SPTO Configuration Tool, 
make the led configuration and download the configuration to the module. After 
this, continue with the Relay Setting Tool and make the rest of the SPTO 
configuration and the interlocking program.
4 ABB Automation
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The configuration can be done both on- and off-line. Sometimes you just upload the 
current settings from the SPTO module, make the changes and download it again or 
start from the saved version made earlier or just start from an empty SPTO 
Configuration Tool.

2.2.2. Configuring

The configuration of each LED indication is done by selecting the indicator to be 
configured by a mouse click on it. The selected object is highlighted with a dark 
background color. Now pick the comboboxes to the right, Figure 2.1.-1 item 5, one 
by one and make the settings. Open the list by a click at the arrow and select from 
the list. Continue the same way with the following indication to configure. See also 
Figure 2.2.2.-1.

The selectable options in the 5 different comboboxes, Figure 2.1.-1 item 5, are 
selectable according to the SPTO module in question and already selected options. 
In order to be able to move an indication to another LED location or just delete it, 
you have to free the configured indication by removing the settings from it and 
taking it out of use. Now you can configure the new indication. It is also enough to 
just remove the in-use option, but then the other settings remain visible, but are not 
sent to the module.

)LJ���������� 8QFRQILJXUHG�DQG�FRQILJXUHG�LQGLFDWRU

In Figure 2.2.2.-1 the indicator to the left is unconfigured while the one to the right 
is configured in the following way: In use, which is shown by the surrounding 
square, it is a controllable switching device of any type but circuit breaker with input 
4 and output 26 for OPEN and 27 for CLOSE commands and finally vertical green 
leds indicates closed status.

The configuration can be downloaded to the SPTO module any time. If the changes 
have not been saved or downloaded when exiting the tool, the tool asks whether the 
changes are to be saved or discarded.

The configuration possibilities of the SPTO leds are depending on type. The SPTO 
Configuration Tool is taking the selected SPTO module into consideration and the 
available setting ranges adopted to present module, see Table 3.1.1-1 on page 9 and 
Table 3.1.4-1 on page 10.

2.3. Menus

There are three menus in the SPTO Configuration Tool view (Figure 2.1.-1 item 1). 
Descriptions for the functions provided in the menus are presented in the following.
B Automation 5
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2.3.1. File menu

The File menu (see Figure 2.3.1.-1) contains functions for saving of the settings and 
exiting of the program. These functions are selected by clicking on the appropriate 
alternative in the File menu.

)LJ���������� 7KH�)LOH�PHQX

2.3.1.1. Save Ctrl+S

By selecting this option the configuration is saved.

2.3.1.2. Exit

By selecting this option, the program exits the SPTO Configuration Tool and returns 
to the Project Structure Navigator

2.3.2. Transfers menu

)LJ���������� 7UDQVIHUV�PHQX

The Transfers menu, (see Figure 2.3.2.-1), contains commands used to 
communicate with the relay module. The desired option may be opened by clicking 
the relevant field in the Transfers menu with the mouse button.

2.3.2.1. Upload...

)LJ������������ 8SORDG�GLDORJ�ER[

Only parameters concerning the configuration of leds are uploaded, (i.e. read from 
the SPTO module in question to the SPTO Configuration Tool).
6 ABB Automation
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2.3.2.2. Download...

)LJ������������ 'RZQORDG�GLDORJ�ER[

Parameters are downloaded, (i.e. written to the SPTO control module from the 
SPTO Configuration Tool). The progress is shown in the Download dialog boxes 
(see Figure 2.3.2.2.-1). The download operation is automatically carried out in 
several steps, according to the programming technique of the SPTO module:

1. Setting module in programming mode

2. Clearing leds
3. Transfer of settings
4. Setting module back into run mode, which can be done only when there is an 

interlocking program in the SPTO module. Use Relay Setting Tool to make 
necessary interlocking program lines and activate the interlocking program by 
setting parameter S199.

5. Storing into non-volatile memory
6. The program gives a status report

2.3.3. Help menu

)LJ���������� +HOS�PHQX

The Help menu (Figure 2.3.3.-1) contains only the About Setting Tool dialog box 
(see Figure 2.3.3.1.-1).
B Automation 7
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2.3.3.1. About SPTO Configuration tool

)LJ������������ $ERXW�6372�&RQILJXUDWLRQ�7RRO�GLDORJ�ER[

The dialog box About SPTO Configuration Tool, (see Figure 2.3.3.1.-1), contains 
information concerning the current version of the SPTO Configuration Tool.

2.4. Toolbar buttons

The toolbar buttons below, (also presented as item 2 in Figure 2.1.-1), provide the 
same function as the corresponding options in the File menu and in the Transfers 
menu.

Table 2.4.-1 Toolbar buttons

Exit to the Project Structure navigator

Save the configuration

Upload parameters (data read from the module)

Download parameters (data sent to the module)
8 ABB Automation
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3. Rules for configuring SPTO LEDs

3.1. General for all types of SPTO modules

Following recommendations can be applied onto all SPTO modules concerning the 
configuration of the leds

• Only make configuration for leds in use

• An input should be used only once

• An output should be used only once

• The same inputs and output codes are also used in the interlocking program

OPEN/CLOSE are always tied together in pairs, thus only the OPEN code is us
the SPTO Configuration Tool. Because thereby the CLOSE code is known.

3.1.1. SPTO 6D3 LED setting ranges

SPTO 6D3 can be assigned up to seven status indication objects, i.e seven inp
indication, while controllable outputs up to 6 pieces of which maximum two obje
can be circuit breakers.

The input and output numbers in the above table are the logic definitions used 
SPTO control module instead of using to the physical connections on the rear s
terminals of the SPAC terminal. These input and output codes are also used i
interlocking program.

3.1.2. SPTO 6D3 versions

SPTO 6D3 can have maximum two circuit breakers, identified by circuit break
and circuit breaker 2. From version 055N of the SPTO 6D3 module distinction
made between CB1 and CB2, while older versions use the same identification
both, despite of the fact that they still are presented as CB1 and CB2. The SP
Configuration Tool reads the module version the first time communication is 
established.

The easiest way of checking the version is by means of Relay Setting Tool. Up
the parameters in the group Configuration of objects and the version is shown
screen 1, see Figure 3.1.2.-1.

Table 3.1.1-1 SPTO 6D3 setting ranges for indications

Setting Alternatives Explanation

Object usage Used or not used If not used the following settings are not 
necessary to make.

Vertical leds Open position or 
closed position

This determines whether the vertical leds are 
indicating open or closed status of the objects.

Input number No input
1,2,3,4,5,6,7

The four pole input that is used for the status 
indication.

Output number No control
20, 22, 24,
26, 28, 30

The output numbers used for OPEN/CLOSE 
outputs 1 to 6.

Object type Disconnector
Circuit breaker 1
Circuit breaker 2

Define whether the object is a circuit breaker or 
not. All other objects are using the definition 
“disconnector”.
B Automation 9
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)LJ���������� &KHFNLQJ�WKH�YHUVLRQ

3.1.3. SPTO 1D2, 1D5, 1D6 LED setting ranges

SPTO 1D2, 1D5 and 1D6 can be assigned three status indication objects. Three 
inputs for indication can be used and one output for control of an object. Parallel to 
Circuit Breaker CB, a definition called Circuit Breaker Truck is also available.

3.1.4. SPTO 1D2, 1D5, 1D6 LED setting ranges

Table 3.1.4-1 SPTO 1D2, 1D5, 1D6 setting ranges for indications

Setting Alternatives Explanation

Object usage Used or not used If not used the following settings are not 
necessary to make.

Vertical leds Open position or 
closed position

This determines whether the vertical leds are 
indicating open or closed status of the objects.

Input number No input
1,2,3

The four pole input that is used for the status 
indication

Output number No control
20

The output numbers used for OPEN/CLOSE 
outputs.

Object type Disconnector
Circuit breaker 
Truck

Define whether the object is a circuit breaker or 
not. All other objects are using the definition 
“disconnector”. Note, SPTO 1D6 can also use a 
definition called "Truck"
10 ABB Automation
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About This Chapter

This chapter contains information on how to send customer feedback.

Customer Feedback Database

Customer Feedback is a Lotus Notes database which ABB companies can use to 
report errors, make improvement proposals and queries related to products 
manufactured by ABB Substation Automation Oy. The Customer Feedback 
database is connected to the change management system of ABB Substation 
Automation Oy, which handles all error corrections and improvements, made to the 
products.

Please note that the Customer Feedback database is primarily intended for writing 
reports about released products. If you are using for example a beta release in a pilot 
project, this should be clearly stated.

Writing A Customer Feedback Report

When writing a Customer Feedback report the following general instructions 
should be taken into consideration:

• Write the report in English.

• Write only one error report, query or improvement proposal in a Customer 
Feedback Report.

• If you are reporting an error, try to isolate the error as good as possible. Des
the sequence of events and actions causing the error. If any error messages
other debug information is provided by the system, please write it down. Incl
also information of the system, e.g. a system diagram, revision information a
configuration data.

• If you are making an improvement proposal, try to describe how the improve
function should work. Avoid providing solutions. Information about the 
importance of the improvement, e.g. number of projects that require the 
improvement, helps us to make the decision whether and when the improve
should be implemented.

To make a Customer Feedback Report, select Feedback Report from the Cre
menu. This opens an empty Customer Feedback document. Fill out the fields l
below. A question mark next to a field provides help for filling out the field.

� Subject. This should contain a short description of the issue. A more detaile
description can be given in the Description of Feedback field below.

� Type of Feedback: Comment/Improvement, Query or Complaint/Error.

� Customer Information.

� Reporting Information. This should contain detailed information about the 
product that is handled in the report.

� The person who you want to send the feedback to and whether you want to
reply from that person or not.
B Automation
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� Information related to internal handling of the report (not obligatory).

� Category.

You can issue the report by clicking the Issue Feedback button. This will send the 
report to the selected person and change its status to “in progress”.

Actions

When ABB Substation Automation Oy receives a Customer Feedback report i
analysed by a sales person or a representative of the technical support. The an
may ask for additional information in order to complete the analysis. After the 
report has been analysed, the following actions are taken:

• In case of a clear error the report is moved to the change management syste
ABB Substation Automation Oy. In this system the error is analysed in detail 
corrected in a future patch release or major release depending on the severit
impact of the error.

• In case of an improvement proposal the report is also moved to the change 
management system where it is considered as a requirement for future relea

• In case of a query an answer is provided.

When Customer Feedback reports are handled in the change management sy
the outcome can be one of the following:

No Actions This means that it is decided that the
report requires no further action. If for
example the problem is caused by a 
configuration error, it belongs to this 
category.

Will be implemented in patch/current releaseThis means that the correction or
feature will be available in the next 
official program release.

Moved to future release This means that the new feature w
be available in a new program releas
in the near future.
ABB Automation
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